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Change Control 
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1 Preconditions 

The following preconditions must be met to ensure proper functioning: 

 Empower™ is installed according to the Waters instructions. Refer to the Waters 

instructions for information concerning the minimum system requirements. 

 The Metrohm driver is installed according to the instructions (8.102.8068 "Metrohm 

IC Driver for Empower™ installation"). 
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2 Starting Empower™ and creating a node 

2.1 Starting Empower™ 

1. Connect the Metrohm instruments to the PC (via USB) and the power supply. 

2. Switch the PC on. 

3. Switch the Metrohm instruments on. 

4. Start Empower™ by clicking on the corresponding icon on the desktop. 

Note: Ensure that all Metrohm instruments are switched on before starting 

Empower™. In case of issues while starting Empower™, see chapter 12.1 on 

page 78. 
 

5. Enter  your Empower™ user name and password and click on OK. 
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2.2 Configuring the system 

1. Click on Configure the System. 

 

The Configuration Manager opens. Its icon will appear and blink in the lower 

task bar of your screen. 
 

2. Go to Nodes. 

3. Create a new node (i.e. where your instruments are connected to the PC). For this purpose, 

right-click on the table and click on New… > Node. 
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4. Follow the instructions of the wizard. 

 

5. Right-click on the new node and open the Properties menu item. The connection to the 

node will be established. 
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6. Click on Configure DHCP on the Configure DHCP tab. 

 

7. Click on Add…. 
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8. Enter the following parameters: 

Note: If several systems are added, both the IP address and the MAC address have to 

differ. 

Note: All systems that are configured on the DHCP Server must be powered on. 

Parameter Value 

IP Address 000.000.000.xxx, (where xxx = 001-255) 

e.g. start with 000.000.000.001   

MAC Address 00-00-00-00-00-xx, (where xx = 00-99) 

e.g. start with 00-00-00-00-00-01   

Instrument Type Select Metrohm IC.  

This includes all implemented Metrohm 

instruments, also Sample Processors and Dosinos. 

Serial Number / Unique 

Name 

These are the actual settings used to detect the 

instrument on the USB bus. They must meet the 

requirements below. 

 

Requirements for the Serial Number / Unique Name: 

 The serial number must be the last six characters (including leading 0s) printed on the 

serial number sticker found on the back of the instrument. 

 The serial numbers must be prefixed with the following abbreviations (excluding 

double quotes): 

 IC-instrument:  "IC=" 

 Sample Processor: "SP=" 

 Sample Center: "SC=" 

 Detector (Stand Alone): "DT=" 

 If you are using multiple instruments, you can combine them. Any combinations are 

possible. In this case, the serial numbers must be separated by a space. The order of 

the different modules is freely selectable. 

Examples (excluding double quotes):  

 IC only:  "IC=003127" 

 SP only: "SP=003534" 

 SC only: "SC=100062" 

 DT only: "DT=004101“ 

 Combination: "IC=003127 SC=100062 DT=004101" 
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9. When entered the values, click on OK. 

Example: 

 

10. Click on OK. 
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11. Click on OK. 
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Removing an instrument 

1. To remove a not used instrument, select the instrument by clicking on the number of the 

corresponding row and click on Remove Instrument. 

 

2. Click on Configure DHCP on the Configure DHCP tab. 

3. Select the instrument you want to remove and click Remove. 
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3 Setting up a chromatographic system 

3.1 Generating a system 

1. Go to Systems. 

 

2. Create a new system by selecting the New > Chromatographic System menu item. 
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3. Select Create New System and click on Next. 

 

Detailed explanations 

Field Explanation 

Create New System 

 

Specifies that you create a new chromatographic system using 

available instruments connected to an acquisition server. It is 

not necessary that the system is directly connected to your 

Empower™ workstation. 

Connect to Existing System 

 

Specifies that the current user can access the selected 

chromatographic system. If the system is password-protected, 

you need the password to access the system. Then you can use 

the chromatographic system to acquire and process data and 

to generate reports. 

 

4. Click on Next. 

5. Choose (client/server) acquisition server. 

6. In case of a client/server installation, the node must be selected on which the Metrohm IC 

Driver for Empower™ was installed. 

  

c 

c 
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7. Click on Next. 

 

3.2 System selection 

1. Select an instrument from the Available Instruments list and drag it to the list beneath New 

System Instruments. You can use instruments from the Unused Components and an 

existing system. If the instrument is not in the Available Instruments list, click on Cancel 

and check the properties of the acquisition server. 

 

Note: With one chromatographic system only one IC instrument can be controlled. It is not 

possible to control multiple IC instruments with one chromatographic system. For this 

purpose, two different chromatographic systems are required (see chapter "Restrictions" on 

page 80). 
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2. Click on Next. 

Note: You cannot drag the last instrument from an existing system. To free up the last 

instrument, delete the system. 

 

3.3 Access Control 

Use this window to control how other users access the new system you are creating. You can share 

the system with other network users and password-protect it. 

Note: If you have access to a chromatographic system, you do not need to enter the password 

unless you are crossing databases. 
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1. If required, enable the fields under Allow Access to Group(s). 

 

Detailed explanations 

Field Explanation 

Share System with Other 

Network Users 

Specifies that other network users (determined by the access 

option you select; see below) can use the system. If you select 

this option, consider password-protecting the system to limit 

its use to authorized users. 

Allowed Access 

Owner Only Specifies that the owner of the chromatographic system and 

users with administrator rights can access the selected 

chromatographic system. 

Owner and Group(s) Specifies that the owner of the chromatographic system, 

group members as specified in the Allow Access to Group(s) 

list and administrators can access the selected system. Group 

access only allows a user to operate a chromatographic 

system. 

Note: To modify a chromatographic system, you need access 

to the chromatographic system and its acquisition server. 

Owner, Group and World Specifies that all users in the database can operate the selected 

chromatographic system. 
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Password Protect System Access 

Password Required Specifies that users enter a password before they can access 

the selected chromatographic system across databases. 

Password Specifies that a password (up to 30 alphanumeric characters) is 

needed to access the selected chromatographic system across 

databases. 

Confirm Password Requires reentry of the password to confirm that it was spelled 

correctly. 

Allow Access to Group(s) 

 Select the user group(s) that you want to give access to the 

selected chromatographic system. Access rights of these user 

groups override access rights of the selected World user type. 

If you select Owner, Group and World, groups that were not 

selected in the Allow Access to Group(s) list are assigned the 

World user type access. 

 

2. Click on Next. 

3. Enter a system name and click on Finish to complete the setup of the new chromatographic 

system and to close the wizard. 
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Detailed explanations 

Field Explanation 

System Name Identifies the chromatographic system in the Empower™ 

database and in the Configuration Manager. Up to 30 

alphanumeric characters are allowed for the system name. Use 

a meaningful system name in case other users have access to 

the system. 

Acquisition Server Name Name of the acquisition server to which the selected system is 

connected. This field is not editable. 

Online If all configured system instruments are available (not 

configured in another online system), this brings the new 

system online. Default: selected. 

System Comment Displays optional remarks (up to 250 characters). Comments 

that describe the chromatographic system, its components and 

its intended use can help others if they have access to the 

system. 

 

4. The following Message appears. 

5. Click on OK. 
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6. Check if the system is online. If not, bring it online by right-clicking on the system and clicking 

on Bring Online. 

 



 

22 ▪▪▪▪▪▪▪ 

4 Creating a project 

1. Create a new project by selecting the New > Project menu item. 

 

2. The Tablespace form appears. 

3. Click on Next. 
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4. Click on Next. 

 

5. Click on Next. 
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6. In the Projects tree view, select an appropriate project for already existing settings. 

7. Click on Next. 

 

8. Enter a Project Name. 

9. Click on Finish. 
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5 Creating an instrument method 

Note: An already existing instrument method can only be used with the same system configuration 

the instrument method has been created with. 

5.1 Opening the Run Samples interface 

1. In the Empower™ start window, go to Run Samples. 

 

2. Choose your chromatographic system and click on OK. 

Note: In this manual, we will show you how to create an instrument method using the Pro 

interface. For a quick set up of an instrument method, click on Use QuickStart. The basic 

principle for the QuickStart is the same as described in this procedure. 

 

A Run Samples session is initiated. The corresponding icon in the task bar 

appears. 
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3. Wait until the instrument status changes from INITIALIZING to IDLE. This may take several 

minutes. 

4. As soon as the instrument status has changed to IDLE, select Edit > Instrument Method. 

 

 

5. The window shows all modules of your setup in a tree structure. Select a module and enter 

the desired start parameters.  
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5.2 Setting the start parameters 

Note: The selection option with the tabs depends on the instrument types. 

Note: To set the parameters for a device, you first have to activate the device by checking the 

checkbox Active. 

Example: 

 

5.2.1 Setting the parameters for the different possible modules of an ion 

chromatograph 

The following screenshots show start parameters for a typical anion setup. 

IC – Gradient 

 

Detailed explanations 

Parameter Explanation 

Flow Flow of the high-pressure pump when starting the method. 

Pmin Minimum pressure when starting the method. If the pressure is 

below the entered minimum pressure, the high-pressure pump 

switches off automatically. 

Pmax Maximum pressure when starting the method. If the pressure 

is above the entered maximum pressure, the high-pressure 

pump switches off automatically. 

Start-up time When activated, a start-up time for reaching the defined 

flowrate can be defined. 

http://www.dict.cc/englisch-deutsch/high-pressure.html
http://www.dict.cc/englisch-deutsch/pump.html
http://www.dict.cc/englisch-deutsch/high-pressure.html
http://www.dict.cc/englisch-deutsch/pump.html
http://www.dict.cc/englisch-deutsch/high-pressure.html
http://www.dict.cc/englisch-deutsch/pump.html
http://www.dict.cc/englisch-deutsch/start-up.html
http://www.dict.cc/englisch-deutsch/time.html
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Number of pumps Determines the amount of connected high-pressure pumps 

Pump A-D To assign the pumps to pumps A-D. 

Eluent A-D Determines the mixing ratio of the eluents when starting the 

method. The total in percent has always to be 100. 

 

IC – Column Heater 

 

Detailed explanations 

Parameter Explanation 

Wait for Stable Temperature If this option is switched on, then a determination will not start 

until the set temperature has been reached and is stable. 

Temperature Temperature that is set for the column heater when the 

hardware is started. 

 

IC – Degasser 

 

Detailed explanations 

Parameter Explanation 

On Determines whether the device is switched on when the 

hardware is started or not. 

http://www.dict.cc/englisch-deutsch/high-pressure.html
http://www.dict.cc/englisch-deutsch/pump.html
http://www.dict.cc/englisch-deutsch/mixing.html
http://www.dict.cc/englisch-deutsch/ratio.html
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IC – Injector 

 

Detailed explanations 

Parameter Explanation 

Position Position of the injection valve when the hardware is started. 

 

IC – MCS 

 

Detailed explanations 

Parameter Explanation 

On Determines whether the device is switched on when the 

hardware is started or not. 
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IC – MSM 

 

Detailed explanations 

Parameter Explanation 

Automatic stepping to next 

position during equilibration 

If this option is enabled, then – after the method is loaded – 

automatic stepping of the rotor to the next position is initiated 

within the equilibrate mode. The time interval defined in the 

parameter Interval is used. 

Interval Time interval between 2 sequential automatic rotor stepping 

operations. 

 

IC – Peristaltic 

 

Detailed explanations 

Parameter Explanation 

Rate Rate of the peristaltic pump when the hardware is started 

On Determines whether the device is switched on when the 

hardware is started or not. 
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IC – Dosino 

Note: The dosing devices (Dosinos) have to be connected to the instrument before the system is set 

up, because they are not plug-and-play devices. 

The Dosinos can be connected to the following devices: 

 IC devices 

 Stand-alone detectors 

 IC sample processors 

Connecting dosinos to the sample center is not possible. 

Note: Dosino default settings normally do not require any modification. 

Note: If a Prep or Empty command is performed with the Dosino, then the "Dosing Port 1" will 

always be used as the port for ejecting the solution (Port for Prep/Empty). 
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IC – Remote Box 

 

Detailed explanations 

Parameter Explanation 

Output signal Input of the binary pattern for the output signal of exactly 14 

characters. 

0  =  Output line deactivated 

1 =  Output line activated 

* =  Retain the status of the output line 

p =  set pulse (pulse length = 200 ms). If an impulse with a 

different length is to be emitted, you can enter the desired 

value in the field Pulse Length. 

The output lines are numbered from right to left:  

13-12-11-10-9-8-7-6-5-4-3-2-1-0 

Examples: 

********1***** : Sets the status of output line 9 on active. 

****0********* : Sets the status of output line 5 on deactive. 
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IC – Extension Module – Degasser 

 

Detailed explanations 

Parameter Explanation 

On Determines whether the device is switched on when the 

hardware is started or not. 

 

IC – Extension Module – Injector 

 

Detailed explanations 

Parameter Explanation 

Position Position of the injection valve when the hardware is started. 
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IC – Extension Module – Pump 

 

Detailed explanations 

Parameter Explanation 

On Determines whether the device is switched on when the 

hardware is started or not. 

Flow Flow of the high pressure pump when the hardware is started. 

Pmin Minimum permitted pressure in the system when the hardware 

is started. The high pressure pump automatically switches off if 

this pressure level is not reached. 

Pmax Maximum permitted pressure in the system when the 

hardware is started. The high pressure pump automatically 

switches off if this pressure is exceeded.  

Use start-up time When activated, a start-up time for reaching the defined 

flowrate can be defined. 

  

http://www.dict.cc/englisch-deutsch/start-up.html
http://www.dict.cc/englisch-deutsch/time.html
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5.2.2 Setting the parameters for the Conductivity Detector 

 

Detailed explanations 

Parameter Explanation 

Temperature Coefficient Temperature coefficient that is set when the hardware is 

started. The temperature coefficient corrects the measured 

conductivity of the detector at the operating temperature to 

the conductivity at the reference temperature 20 °C.  

Cell Temperature Selecting thermostat temperature of the detector block. 

Cell Constant Cell constant of the measuring cell. 
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5.2.3 Setting the parameters for the Amperometric Detector 

 

Detailed explanations 

Parameter Explanation 

Mode Selection of the measuring mode of the amperometric 

detector. Following measuring modes are available: 

 DC: Measurement with constant potential. 

 PAD: Measurement with several potential steps. 

 flexIPAD: Measurement with flexible potential steps 

(levels, ramps) and integration. 

Temperature Temperature that is set in the detector when the hardware is 

started. 

Monitor temperature 

stability 

If this option is switched on, then a determination will not start 

until the set temperature has been reached and is stable.  

If this option is switched off, then the sequence of a 

determination will not be influenced by the temperature. An 

attempt will indeed be made to achieve the temperature and 

to maintain it, but the determination will begin in any case.  

Settings Opens the dialog for setting the parameters of the selected 

measuring mode of the amperometric detector. For further 

information concerning the settings for the different modes, 

see below. 

 

Settings for the different measuring modes 

The following measuring modes are available. Select the desired mode and click Settings to change 

the parameters. 
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DC 

 

Detailed explanations 

Parameter Explanation 

DC potential Potential of the working electrode in comparison to the 
reference electrode. 

Range Selection of the measuring range. 

auto: Automatic setting of the measuring range. This selection 
is not allowed with damping activated. 

Damping Switching the auxiliary damping on or off. 
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PAD 

 

Detailed explanations 

Parameter Explanation 

Duration [ms] Duration of the potential step in milliseconds. 

Sum Duration [ms] Cumulative duration of potential steps 1 - n in milliseconds (n = 

number of the observed potential step). 

Potential [V] Potential of the step in volts. 

Cycle duration Display of the total duration of the potential profile in 

milliseconds (sum of the durations of the individual steps). 

Duration Duration of the measurement. 

Range Selection of the measuring range. 
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flexIPAD 

 

Detailed explanations 

Parameter Explanation 

Duration [ms] Duration of the potential step in milliseconds. 

Sum Duration [ms] Cumulative duration of potential steps 1 - n in milliseconds (n = 

number of the observed potential step). 

Start potential [V] Start potential of the step in volts. 

End potential [V] Terminal potential of the step in volts. 

Cycle duration Display of the total duration of the potential profile in 
milliseconds (sum of the durations of the individual steps). 

Start Start time of the measurement. 

End Ending time point of the measurement. 

Range Selection of the measuring range. 
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5.2.4 Setting the parameters for the IC Sample Processor 

Sample Processor – Peripherals Tower 

Note: These values are dependent on the racks and sample vessels used. 

Note: The needle of the Sample Processor can only move to positions on the rack used (no external 

positions such as the rinsing station). 

 

Detailed explanations 

Parameter Explanation 

Home The home position is usually the uppermost stop of the lift. 

Work Usually at this lift position the sample is taken. 

Rinse This lift position is used for rinsing. 

Shift Each time that the rack shifts, the lift will move to this position 

if it is located at a lower lift position. If the lift is located at a 

higher lift position than that defined here, then the shifting will 

take place at the current lift position. This means that the shift 

position must be selected so that a safe movement across the 

entire rack is possible at any time. 

Special This additional definable position can be used e.g. during 

pipetting so that the tip is just immersed in the sample 

solution. 
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Sample Processor – Peristaltic Pump 

 

Detailed explanations 

Parameter Explanation 

Rate Rate of the peristaltic pump when the hardware is started. 

On Determines whether the devide is switched on when the hardware 

is started or not. 

5.2.5 Setting the parameters for the Sample Center 

Note: Needle or rack commands can only be processed if the door of the 889 sample center is 

closed. If the door is open, the state of the module changes to "Error" (indicated by the red LED on 

the 889 and a corresponding message in the Empower™ message center). In this case, go to 

Manual Control and select the command Reset Device in the folder General. If the command 

Reset Device does not work, reset the system according to chapter 12.1 on page 78. 

Compressor 

 

Detailed explanations 

Parameter Explanation 

On The compressor is switched on when the hardware is started. 
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Cooling 

 

Detailed explanations 

Parameter Explanation 

On The cooling is switched on when the hardware is started. 

Temperature Temperature that is set for the cooling when the hardware is 

started. 

 

Injector 

Note: The range of the injection volume is depending on the injection mode. If the volume is outside 

the respective range, the instrument will switch to failure. The maximum injection volume is 

calculated in accordance with the following formulas: 

 Full loop: injection volume = sample loop volume 

 Partial loopfill: max. injection volume = 0.5 × sample loop volume 

 Pickup: max. injection volume = (sample loop volume – 3 × needle volume) / 2 

 

 

Detailed explanations 
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Parameter Explanation 

Position Position of the injection valve when the hardware is started. 

Sample loop volume Volume of the sample loop of the injection valve, in µL. 

Note: The injection volume in the sample table has to fit to the 

entered value in the field Sample loop volume. For further 

information refer to the 889 Sample Center user manual. 

 

Needle 

 

Detailed explanations 

Parameter Explanation 

Needle height Vertical distance of the needle tip from the bottom of the vial 

or the cavity of the micro titer plate. 

Volume needle to valve Whole volume, from the needle tip to the injection valve, in µL. 

 

Note: For information how to exchange the needle, refer to the IC sample center manual 

(8.889.8001EN). 
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Rack 

 

Detailed explanations 

Parameter Explanation 

Type Selection of the rack type. 

 

Syringe 

 

Detailed explanations 

Parameter Explanation 

Syringe volume Display of the volume of the syringe in µL.  

Buffer loop volume Volume of the buffer loop in µL.  
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Define plates for sample set method 

The following screenshots show the correct configuration of the 889 sample center. 

1. To enter the configuration, click on the Plates symbol in the Run Samples section and click on 

Create New Plate Type. 
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Note: Pay attention to select the correct Plate Sequencing Mode. 
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Defining the sample positions when measuring two channels 

When measuring two channels (with two different solutions, e.g. anions/cations) with one time 

program, you have to define the sample positions in the time program. 

Note: If you are using the +1 command as described below, you cannot use a predefined injection 

mode (e.g. Full Loop Injection). In this case you have to write the sequence for the injection manually. 

When adding a Move to Position command, check the checkbox +1. 

 

Checking the checkbox +1 has the following meanings: 

 LA1 + 1 = LB1 

 LF1 + 1 = LA2 

 LF8 + 1 = RA1 

 RF8 + 1 = RA9 (is invalid) 
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5.3 Creating the time program of the method 

Write a time program to set the chronological order of the action of your measurement. 

Commands can be selected with Add…. 

 

 

Depending on the instrument type, an IC instrument can perform the following actions: 

Commands IC instrument (depending on the 

instrument type) 

Commands Amperometric Detector 
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Commands Sample Processor Commands Dosino 

 
 

 

Device-independent commands are commonly used for the execution of subprograms. Subprograms 

can be used to create more complex time programs. 
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5.3.1 Time program – Example 

To start a simple time program, you can proceed as follows: 

1. Double-click on Move to position. 

 

2. Select Sample Position. 

 

The first line in the time program looks as follows: 
 

 

3. With Add… more lines can be added, e.g.: 
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Actions of indefinite time are highlighted in gray in the time program. The time counter restarts at 

zero after such a command. 

4. Save your instrument method (e.g. as "AnionInstrument" to make clear that this is an 

instrument method). 

 

Example for an An/Cat method: 
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5.4 Creating an offline method 

The offline method allows you to create a method without any devices connected to your PC. The 

following prerequisites have to be fulfilled that you can create an offline method and afterwards use 

it for your analysis: 

 When creating an offline method no device has to be connected to the PC. If however there is 

a device connected to the PC, setting up an offline method is not possible. 

 Ensure that the configuration of the node and the system correspond with the real system you 

you will connect to the PC afterwards. Otherwise there will be an error message when you try 

to use the method for your analysis. 

To create an offline method proceed as follows: 

1. If not yet done, disconnect all Metrohm devices connected to the PC. 

2. Create a new node as described in chapter 0 on page 7. 

3. Insert the parameters for the DHCP. In case you want to use the method for your analysis 

afterwards, ensure that the values correspond with the real system values. 

4. Right-click on Instrument and click Add Instrument. 

  

5. Select the desired instrument in the drop-dow list Type. If you want to connect any MSB 

devices, select them in the drop-down lists below. The numbers belong to the following 

devices: 770 Remote Box, 800 Dosino. 

  

6. Click on Apply in the lower right corner. If the button is not visible, maximize the window. 

7. If desired add more devices by right-clicking on Instrument. For detailed information refer to 

chapter 0 on page 7. 
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6 Creating a processing method 

1. Click on Edit > New Method Set... 

 

2. Click on Edit in the line Default Processing Method. 
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The following window appears: 

 

3. Select the processing type and the integration algorithm, and then click on OK. 

4. Make a list of the analytes and their retention time under Components. 

 

5. Open the tab Components to define the retention times of the analytes and the desired 

calibration parameters. 
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The processing method can be adjusted later. It is not necessary to fill in all parameters. It is 

possible to start with the default settings. 

6. Enter the levels of your standard solutions on the tab Default Amounts. 

 

7. The integration parameters can be set on the tab Integration. 

 

8. Save the processing method by clicking on the save button . 

9. Enter a name for the processing method and click on Save. 
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7 Forming a method set 

1. Click on Edit > New Method Set… 

 

2. Group your Instrument Method and your Default Processing Method to a Method Set. 

Default Report Method and Export Method are optional. 
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Note: If you measure two different channels simultaneously, select them in the tree view 

Data Channels and drag them to the table beneath. You can assign to each channel a 

Processing Method. 

 

3. Save your method Set by clicking on the Save button  . 

4. Enter a name for the method set and click on Save. 

 

http://www.dict.cc/englisch-deutsch/simultaneously.html
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8 Measuring cations 

For non-suppressed cation determination, the peaks in the live display are negative. In the analysis 

results, the chromatograms are displayed correctly (with positive peaks). For anion determination, the 

peaks are always positive. 

If the analytes are measured as negative peaks, the chromatogram has to be inverted by means of a 

derived channel. This means that the conductance measured is multiplied by "-1". In order to swap 

the chromatogram, modifie the method set as follows: 

 

1. Open the desired method set by chlicking on Edit > Open Method Set… 

 

2. Create a derived channel by right-clicking on Derived Channels > New > Derived Channel. 
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3. For the derived channel, the conductivity needs to be multiplied by "-1" to obtain the inverse: 

 

 

4. Give the derived channel a name. 
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5. Choose a processing method for the cation channel. 
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9 Running samples 

9.1 Creating a sample table and starting the analysis 

Note: The instrument status must be IDLE before starting a measuring series. 

 

1. Start filling in the sample table. 

 Start with a line for equilibration of the system. 

Use the Equilibrate function for this. 

 Enter a long run time (e.g. 30 min). 

This makes sure that the system has a stable baseline before moving on to the next 

line. 
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2. Create a sample table according to your needs. 

 

3. To start the series, click on the Run button (only if the instrument status is IDLE). 

 

4. Enter a name for the sample set and click on Run. 

Note: For information regarding the shutdown method, refer to chapter "9.2 Using a 

Shutdown Method" on page 64. 

 

  



 

▪▪▪▪▪▪▪ 63 

5. When your baseline is stable, you can click on Abort and select the Abort run and 

continue on next line option. This will result in a short stop of all modules. 
 

 

 

The Abort Run command has the following results: 

 Abort Now: The current run including all modules stops immediately. Some values in 

the status window are freezed. 

 Abort after Vial is completed: The run stops after completing all injections from 

the current vial, on the current row in the Samples table. The modules do not stop. 

 Abort after Injection is completed: The run stops after completing the current 

injection. The modules do not stop. 

 Abort current run and continue on next line: The run including all modules stop 

on the current row. Then, continues acquisition with the next row in the sample set 

method. 

Note: If a shutdown method is selected (see chapter 9.2 Using a Shutdown Method) and the option "Do 

not Run Shutdown Method During User Abort" is not activated, the shutdown method will be executed 

subsequently. 
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9.2 Using a Shutdown Method 

A shutdown method is downloaded to the instrument at the end of the sample set. This allows the 

user to deactivate not used devices. 

 

9.2.1 Creating a Shutdown Method 

To create a shutdown method, proceed as follows (example): 

1. Create a new instrument method (see chapter "Creating an instrument method" on page 25). 

2. Switch off the following devices by unchecking the checkbox On: 

 

 Column Heater 

 Degasser 

 MCS 

 Peristaltic 

 Pump 1+2 
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3. Open MSM and uncheck Automatic stepping to next position during equilibration. 

 

4. If you are using the amperometric detector: Open the Time Programm. 

5. Click Add. 

6. Go to Professional Detector Vario > Amperometric Detector > Cell On/Off. 

 

7. Uncheck Cell On and click OK. 

 

8. Save the instrument method. 
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9.2.2 Restrictions 

When using a shutdown method, take into consideration the following restrictions: 

 Empower™ will show status IDLE and accept user input while the time program might still be 

running. Before starting a new sample set, ensure that the shutdown method is finished. 

 In case of a shutdown method, Empower™ does not pass sample location information. So any 

time program entry that tries to use this information will fail. 

Example: The command „Move to position“ in the time programm below will not be 

executed and the time program fails. 

 

9.3 Manual control 

Under Manual Control, all hardware components can be operated individually (only when no 

measurement is running). The manual control is located next to the status parameters.  

     

The Status tab displays the current state of the instrument and its modules. For further information 
concerning the numbering of the modules refer to chapter 11 on page 75. 
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9.4 Equilibrating the system 

You can use the method which you use afterwards for the analysis to equilibrate the system. For this 

purpose add the function „Equilibrate“ to the sample table. In this case, only the command "Measure 

Cond./Measure Current" of the time program will be executed. The other commands of the time 

program will not be executed. 

Additionally it might be useful to create an “Equilibration” method. For this purpose create an 

instrument method named "Equilibration" (all parameters as desired, e.g. pump flow 0.7 mL/min, 

MSM autostep all 10 min, etc.). In the time program enter just one line to start data acquisition to be 

able to monitor the baseline during equilibration. 

 

Create also a method set “Equilibration”. This method set can be run in the first line of each sample 
table. 
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10 Evaluating recorded data 

1. To review recorded data, go to Browse Project in the Empower™ start window. 

 

2. Select the desired projet in the project tree and click on OK. 

 

3. Right-click on the name of the sample set and choose review. 
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4. The  icon shows the calibration. 
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5. Several results can be loaded into the review by highlighting them and then opening the 

review window. Use the icon   to overlay curves. 

 

6. For a report, right-click on the desired sample and select Preview. 
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7. A selection window appears in which you can select an appropriate Report Method: 
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8. The report can be modified as required using the Edit Method button. 

 

9. The information can be applied directly to the report by double-clicking on the corresponding 

fields. 

10.1 Example 

Among many other things, the report can contain the chromatogram, the calibration curve, 

instrument parameters (e.g. information on the column and the cell used) as well as the time 

program. A rudimentary example is shown below: 
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11 Numbering of the modules 

The numbering of each module is depending on its position in the daisy chain. The daisy chain 

defines how multiple modules are wired together in sequence. 

 For the IC instrument this means: The upper module always gets the number 1, the lower 

module number 2 (for pumps and injectors, see image below). 

 For the extension modules this means: Only one extension module can be connected directly 

to the IC instrument. The second extension module has to be connected to the first and the 

third to the second. The numbering of the modules begins with the IC instrument and 

continues with the extension modules according to their position in the daisy chain. 

Note: The numbering is fix and cannot be changed manually. 

The following illustrations show the numbering of the modules for different system configurations. 

Extension modules are connected to the IC instrument. 

 

 
In the Empower™ status panel the system configuration above looks like this: 
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Extension Modules are connected to  the detector. 

 

 
In the Empower™ status panel the system configuration above looks like this: 
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1 extension module is connected to the IC instrument and 1 extension module is 

connected to the detector. 

 

 
In the Empower™ status panel the system configuration above looks like this: 
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12 Troubleshooting 

12.1 Message Center 

1. Double-clicking on the "E" in the task bar opens the Message Center, in which error messages 

are documented. 

 

2. A list of all current messages appears (example list). 
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12.2 Stopping the process 

If there is a system failure or if the connection is lost, proceed as follows to restart Empower™ : 

1. Close Empower™ . 

2. Stop InstrumentServer.exe (with Task Manager/Processes). 

 

3. Power down all Metrohm instruments. 

4. Power down and restart the PC. 

5. Power up all Metrohm instruments. 

6. Restart Empower™ by clicking on the corresponding icon on the desktop. 

7. Open Run Samples. 
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13 Restrictions 

 This device driver allows you to operate one or several IC systems from one PC. One 

IC system may maximally include the following modules: 

 One Sample Changer (889 Sample Center or 858 Professional Sample Processor) 

 One Professional Detector Vario – Amperometry (2.945.0020) 

 Two IC conductivity detectors (2.850.9010) 

 The number of MSB devices (e.g. Dosinos) depends on the number of available ports 

(according to the system configuration). 

 Two Metrohm IC instruments can be operated in parallel in two different systems. 

 Two 858 Professional Sample Processors cannot be operated with one PC. 

 The remote box does not work with the 858 sample processor. If you use a remote 

box, plug it in the IC instrument or the detector. 

 The last data acquisition (using measure current or measure conductivity in the time 

program) has to start within 10 minutes from t = 0. Otherwise the whole run will 

abort. 
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14 Importing example methods 

1. Go to Configure the System in the Empower™ start window. 

 

2. Go to File > Restore Project(s) or click on the Restore Project(s) button  . 
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3. Browse to find the desired project. 

 

4. Click Next until finished. 

The imported project will not only contain exemplary chromatograms, but also all instrument 

methods and processing methods that were used to record them. 
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